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What is EndNote?

Reference management software

® Developed by Clarivate Analytics

Personal Reference database
® Storing, managing, and searching for bibliographic references in your private

reference library

Bibliography and manuscript maker

® Formats citations in Microsoft Word with the Cite While You Write™ feature



How EndNote Works

Books, Journals, Create bibliography Report, Manuscript,
Research Articles, E- Thesis, etc.

database, etc



Compatibility and System Requirements

Operating System Word processor software

Windows * Windows 10 Microsoft Word [CWYW] :
e Windows11l « 2010
2013
2016
e 2019
e Office 365 (locally installed desktop version only)

Macintosh * mac0S10.14 Microsoft Word [CWYW] :
* mac0S10.15 « 2016

* macO0S11 e 2019

* mac0S 12 » Office 365 (locally installed desktop version only)
* macO0S13

https://endnote.com/product-details/compatibility



https://endnote.com/product-details/compatibility

Download Endnote Software (1)

1. Go to https://softwaredownload.mahidol.ac.th/ (Access through MU-WiFi or VPN).

2. Login with the MU Internet account.

.8 Mahidol University
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Software
Download
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e Key License

F\\ Adobe <\ Martan

EndNote”

#N% Mahidol University

Sign in

with your Mahidol University Accounts.

Username

Password

Forgot password?



https://softwaredownload.mahidol.ac.th/

Download Endnote Software (2)

3. Download an installer compatible with your operating system. (Windows or Mac).
4, Download the EndNote key license.

L\ UH1DNoavukaa,
_ ) Mahidol University &
S Wealow ot Lol

Mahidol Software License

EndNote 21 for Windows .
= 3| ryueeixg
.- 4 Marias SPSS
Microsoft

_ Microsoft Office Application EndNOte 21 for MCIC Ty
Windows h Ala
[ B I 9 4
‘H ‘ Digital Security

Key License EndNote 21

Antivirus

Key License
VPN

Copyright © 2023 Mahidol University. All rights reserved. E-mail: consult@mahidol.ac.th Phone: 662-849-6022




Get Started with EndNote

*EndNote Library Components
*Creating a New Library
*Library Overview

e Journal Term Lists



EndNote Library Components

» EndNote libraries are made up of two parts:

|4 [ = | My Research Project - b X - EndNote Library file (*.enl)
rome [ S v ° Data folder (*.Data)
L Move to [ Delete = LI:‘ ﬂ_ HH select all .
| o — ]~ | Select none These two parts must be kept together to work
Finto Quick Copy Paste Copy to Eename Mew Froperties )
access d| folder o ) DD Invert selection |
Clipboard Organize Mew Open Select CorreCt y
yN » My Research Project » w | 0 Search My Research Project
2 E1) Testenl > Keep EndNote libraries on your computer’s

7 Ouick access Test.Data J EndMote Library

I Desktop ; V| 4bytes local hard drive. Storing and editing libraries on

¥ Download a network drive can lead to corruption and
& Onelrive .

performance issues.

A Thiz PC

J 30 Objects

B Desktop » EndNote libraries should never be stored in

== Documents ' .

& Downloads cloud-syncing folders such as Google Drive,

d Music OneDrive, etc. Syncing folders corrupts

= Pirtures

2 items 2 B EndNote libraries over time.




Creating a New Library

1. Go to File > New... or select Creating a New Library from the Setup Endnote Library box.

2. EndNote presents a dialog prompting you to enter a name for your new library.

3. Select the location where you will save the library.

4. Click Save, then the new Endnote library appears as an empty library.

Edit References Groups

New...

Upen Library...

Open Shared Library...
Open Recent

Close

Set up EndNote Library

If you already have an EndMNote library, please locate it and we'll get it set up.

Open an existing library

Alternatively, you can start from scratch with a new library.

Create a new library

EN Mew Reference Library 4
4 [ » ThisPC » Documents 3 O Search Documents
Lari+0 Organize » Mew folder - o
Ctrtl+5hift+0 & OneDrive &) Mame Date modified Type
3
B This PC Custern Office Templates 24/3/2563 9:43 File folder
EndMote 26/4/2564 16:28 File folder
Ctrl+W J 3D Objects e 1 .
LDPlayer 2/4/2563 18:19 File folder
I Desktop 2 My Shapes 31/12/2561 12:29 File folder
5| Documents Zoom 22/3/2563 11:51 File folder
4 Downloads
J’.‘ Music
& | Pictures
B Videos
B3 05(C)
U N ol i B
File name: | My EndMote Library.enl 2 -
Save as type: | EndMote Library (*.enl) ~
A Hide Folders 4 Cancel




EndNote 20 - Te

st.enl

File Edit References Groups

% Sync Configuration

(£ All References

Library Tools

Library Overview

Window Help

All References

El No reference selected

Advanced search

L Recently Added
B Unfiled

W Trash

All References -

0 References

&

v MY GROUPS

Author Year Title Journal Last Updateq

v My Groups
v FIND FULL TEXT
v GROUPS SHARED BY ...

v ONLINE SEARCH

@ Library of Congress

@ LISTA (EBSCO)
@ PubMed (NLM)
@ Web of Science C...

mMore...




Library Overview

Groups panel

shows you
both default
groups and
groups or
group sets you
create for your
research

projects.

Menu Bar

File Edit References Groups

Sync Configuration

[l All References
L Recently Added
B unfiled

Tl Trash

v MY GROUPS

V Avian Intelligence

{® Avian Cognition

@\ Corvids

® Corvids & Parrots

®\ Parrots

Vv Bats
®\ Chiroptera

{® Echolocation

{® Echolocation OR So..

@ sonar
> My Groups

“V FIND FULL TEXT

v GROUPS SHARED BY OTHERS

Vv ONLINE SEARCH

@ Library of Congress

@ LISTA (EBSCO)
@ PubMed (NLM)

@ Web of Science Core Co...

more...

Search panel to find an item in your library or to query a

remote database for new references to capture.

v| | Contains

v| | Contains

v| | Contains

All References

Simple search Search options v

|E E Arnett, 2013 #2468 Summary Edit

gl [ES|ES

ARS

Journal Last Updated

Evaluating the .. PLoS One 18-Sep-20

Multi-state occ..  PLoS One 18-Sep-20

Hominids and ..  Proceedings of the National A..  18-Sep-20

New Dataont. Zoologichesky Zhurnal 17-Sep-20

Animal intellig..  Zoologichesky Zhurnal 17-Sep-20

Plant classificat.. Plos Computational Biology 17-Sep-20

An autocorrela..  Biological Cybernetics 17-Sep-20

Mechanisms of.. Auk 18-Sep-20

Azure-winged ..  Behavioural Processes 18-Sep-20

American Museum Novitates

Roosting Ecolo.. 18-Sep-20

The Oxford ha..  Oxford Library of Psychology 21-Aug-19

The Role of Ex..  Current Biology 17-Sep-20

Reference List panel shows you the individual references

stored in your EndNote library, also known as library records.

pone.0065794.pdf v‘

Evaluating the Effectiveness of an Ultrasonic
Acoustic Deterrent for Reducing Bat Fatalities at
Wind Turbines

E. B. Arnett, C. D. Hein, M. R. Schirmacher, M. M. Huso
and J. M. Szewczak

PLoS One 2013 Vol. 8 Issue 6 Pages e65794
Accession Number: 23840369 PMCID: PMC3686786 DOL:

10.1371/journal. pone. 0065794

Large numbers of bats are killed by wind turbines
worldwide and minimizing fatalities is critically
important to bat conservation and acceptance of wind

APA 6th Copy citation

Arnett, E. B, Hein, C. D., Schirmacher, M. R., Huso, M. M., &
Szewczak, J. M. (2013). Evaluating the Effectiveness
of an Ultrasonic Acoustic Deterrent for Reducing
Bat Fatalities at Wind Turbines. PLoS ONE, 8(6),

e65794. doi:10.1371/journal.pone.0065794

Tab panel
The Summary

tab displays a
detailed
overview of a
selected
reference.
Quickly alter
reference
metadata from
the Edit tab.

Preview

panel shows
you how a
reference
would appear
formatted with
a specific

output style.




Journal Term Lists

Journal Term Lists are lists of journal names in full and abbreviated form.

® These lists are used for making correct journal names in reference format.

® Help EndNote work correctly to find out the duplicate references.

Recently Added

2 References

Author Year Title Journal

Li, Zhuo; Hirst, Jonathan D. 2020  Computed optical spectra of SARS-CoV-2 proteins Chemical Physics Letters

Li, Z.; Hirst, J. D. 2020 Computed optical spectra of SARS-CoV-2 proteins Chem Phys Lett

“Retrieving references from various sources may give the journal names in a different form.

ScienceDirect*
give full journal name

PubMed*
give abbreviated journal name



Before & After defining Journal Term Lists

s

i ScienceDirect

Give full journal name

Before

Vancouver e Insert Copy b

1. Li Z, Hirst JD. Comup d optical sp of

SARS-CoV-2 proteinsChemical Physics Letters

2020;758:137935.

After

Vancouver v Insert Copy A

1. Li Z, Hirst JD. Comnputed optical spectra of
SARS-CoV-2 proteinsiChem Phys Lett.

2020;758:137935.

Vancouver Slyle uses the abbreviated journal names



Define Journal Term Lists (1)

1. Go to Library > Define Term Lists...

2.In the Term Lists box, select tab Lists, then select Journals

3. Click on Import List...

Library BTools Window Help

Sync

Advanced Search
Sort Library...

Find Duplicates

Open Term Lists
1 Define Term Lists...
Link Term Lists...

Spell Check
Find and Replace...
Change/Move/Copy Fields...

Recover Library...

Library Summary

Find Broken Attachment Links

Ctrl+4
Ctrl+3

Ctrl+Y

Ctrl+R

]

2

Term Lists

Terms Lists

My_Project_1.enl L

Authors

Journals

Keywords

Dielimiters

Custom Delimiter: |

Carriage return is always used as a term delimiter.

Create List...
Fename List...

Delete List.,.

Update List...
Impaort List. ..
Export List...

Link Lists...

Close




4. Browse to C:\Program Files (x86)\EndNote 21\Terms Lists

Define Journal Term Lists (2)

5. Choose the appropriate term list files (e.g. BioScience.txt), then click Open to complete.

6. Select tab Terms to view the imported journal lists, then close.

9| Open x
1 C:\Program Files (x26)\EndMote 200 Terms Listsl 4 W) Search Terms Lists
Organize + Mew folder tE > [N e
I Desktop " =| Anthropology.tet
4 Downloads =| Archaeclogy.bxt
& OneDrive =| Astronomy and Astrophysics.tct
—| BioScience.xt
3 This PC =| Chemicaltxt Journals w
J 3D Objects =| Ecenomics.txt
I Desktop =| Humanities.tet
= =| Kerean Medical Terms.bt . . . . .
5| Documents ® Law it o 8231 terms inserted into the Journals' term list.
4 Downloads j Medical.txt
d Music =| Philosophy.txt
&=/ Pictures =| Physics.txt
B videos =| Religion.txt
205 (C) =| Zoological Records.txt
v

ﬂ Text fill (*txct) v

5 Open Cancel

File name: | BioScience.tut

Term Lists

Terms Lists

6231 Journals in the Journals List:

Full Journal

& Trends Guide

AACHN Journal

Aarsberet, Mor, Fisk,
Aarsberetning, MORCONS-RY

Aarsheretning. Statens Kartverk

Aarsmelding. Fiskeriforskning
€

Aarsberetning. Morsk Sjoefartsm. ..
Aarsberetning. Sildolje- og Sildem...

Aarsmelding. Eksportutvalget for...

Abbreviation 1 ™

Trends Guide
AAOHM 1.
Aarsberet. Mor.
Aarsberet, MORI
Aarsberet. Marsl
Aarsheret. 55F
Aarsheret. State
Aarsmelding Eks|

Aarsmelding Fisk
>

Hint: Hold the Cirl key to select multiple terms

Mew Term...

o B
UL e

[}
m
m
m
m

=
(%]
m
m

Close




Input Data

*Direct Export
*Import PDF

*Manual Typing



Direct Export

R,
T o e
B

Ej_ ScienceDirect

PublfQed

Scopus’

e

Google Scholar

Import PDF

ml_

Manual Typing

B I UX X Q

Reference Type |Journal Article

Author
Year

Title
Journa
Volume
Part/Supplement
Issue
Pages
Start Page
Errata
Epub Date
Date

Type of Article




Mahidol eJournal Access (EZproxy)

» URL: https://ejournal.mahidol.ac.th

Mahidol University > Login with MU Internet account to access subscribed
Library and Knowledge Center o-resources

Mahidol eJournal Access

P > Support all devices with all operating systems
(Windows, Macintosh, and Linux), smartphones and
tablets with iOS (iPhone / iPad) and Android

I'm not a robot

firstname.sur (for staff) or u61xxx or g61xxx

type your password *** Limitation ***

Must follow the links given on the library’s website



https://ejournal.mahidol.ac.th/

Mahidol eJournal Access (EZproxy)

https://stang.sc.mahidol.ac.th ©:-HE You can access it by
Y Mahidol University Stang Mongkolsuk Library and Information Division 1. Select menu E-Resources
Faticiecene OOl vt L to find appropriated
TN =, o S, e E-Databases, E-Journals, or
| Remote access loff-campus] | E-Books
- 2. Click the URL from the top of

E-JOURMALS

the webpage

E-BOOKS

Search Guides/ Online Tutorials

3. Click edournal Access button

Free Trial Databases
Thai Databases 4. Select appropriated
THAI e-journals IQP"'JOC fHJﬂ U\ “ﬂr%cd iwausnas

E-databases from the bottom

E-THESES

parenTe &u |Pad lWE)ﬂ‘lSﬂﬂU‘\

E-NEWSPAPERS & MEDIAS

of the webpages

"™ E-DICTIONARY

3 Sco p us ScienceDirect S C ] \/O I J°"',;':;§:::ﬁ°" EBSCO §S|F|!\|DER & ACsPublications
Co-learning /D | Stang l'/’_g\\\l elournal g Ele / nature w"};\;!\himmy € SpringerLink d :’g‘éﬁng&v HM BMC ZbMATH-'Open OVid
\ . : \

List of Libraries in Thailand

Space \_.- Training \ i Access

N : (o) W]  GoogleScholar ) turnitin - EndNote™


https://stang.sc.mahidol.ac.th/

Direct export: ScienceDire
enceDirect Journals & Books @ Register

Search for peer-reviewed journal articles and book chapters (including open access content)

Journal/book title Volume Issue Pa m Advanced search
Advanced searc

%]
by
-
(
)]
>
(T
L)

Keyword

The most relevant research on Novel Coronavirus (SARS-
CoV-2) and related viruses is available for free on
ScienceDirect, and can be downloaded in a machine-

readable format for text mining.

Alternatively, visit the Elsevier Novel Coronavirus

Information Center for general health information and

advice.

Visit the Information Center >




Find articles with these terms

Coronavirus

6Adva nced search ‘

_ Export X
T Download 25 articles 2, Export ed by relevance | date

25 citations selected

45,746 results

L\ Set search alert >hort communication

10r and novel coronaviruses, Coronavirus Disease 20’ > Save to RefWorks \ction: what 1s

mowns > Export citation to RIS ‘

Refine by: ertility and Sterility, 16 April 2020, ... S Export ctation to BIbTEX

I:l Subscribed journals

ames Segars, Quinton Katler, ... Jennifer F. Kawwass

» Export citation to text
\bstract v  Extracts »  Export v

Years

[ ] 2022(10)
| ] 2021(12,137)
|| 2020(19,913)

Show more ~

esearch article @ Full text access

-hospital cardiac arrest in patients with coronavirus 2019
esuscitation, 27 January 2021, ...
Dscar J. L. Mitchell, Eugene Yuriditsky, ... Benjamin 5. Abellz

L| Download PDF  Abstract ~  Extracts ~  Export



Direct export: PubMed

National Library of Medicine

National Center for Biotechnology Information

Advanced

PubMed® comprises more than 32 million citations for biomedical literature from MEDLINE, life science journals, and online books.
Citations may include links to full text content from PubMed Central and publisher web sites.




hY WCBI FILTERS [A

RESULTS BY YEAR

TEXT AVAILAEBILITY

[ ] Abstract
[ ] Free full text
[ ] Full text

National Library of Medicine 1. Select the records you need.

National Center for Biotechnology Information

2. Click Send to at the top of search results, then select
Citation manager.

coronavirs 3. Select the options.
e 4. Click the Create file to download data to your library.
Save Email Send to Sorted by: Best match Display options ¢
9% 1 re Clioboard X Clear . L
Ipboar Create a file for external citation management software
My Bibliograp y
v
. fs ph}'{lDE Selection: | Selection (2) (3
f
! Collections pen KY.
mite 009 Oct:2:
Citation manager | . 4 ] Cancel
5 are .
R £ £=Ta [T ) (=T (N
| 2003, there were only 10 corenaviruses .. L L L L o L L L LD oo o,
to December 2008, there was an addition of 16 coronaviruses ...
2021
H il
Broad-spectrum coronavirus antiviral drug discovery. | Selection (2) v
2 | Totura AL, Bavari S. All results on this page
Cite  Expert Opin Drug Discov. 2019 Apr;14(4):397-412. doi: 10.1080/1746044] All results
a. Selection (2)
Share

PMID: 30849247 Free PMC article. Review,

The highly pathogenic coronaviruses severe acute respiratory syndrome coronavirus (SARS-CoV) and



Direct export: SCOpPUS

Search Sources Lists SciVal @ & E Create account

Start exploring

Discover the most reliable, relevant, up-to-date research. All in one place.

fd Documents 2 Authors @ Affiliations Search tips @

Search within
Article title, Abstract, Keywords

+ Add search field [%] Add date range Advanced document search >

v Search documents *

Search History Saved Searches

Start searching and your history will appear here. If you
need help to start searching check out our search tips.



Scopus

196,547 document results

TITLE-ABS-KEY ( coronavirus ) AND ( LIMIT-TO ( PUBYEAR,

2 Edit B Save

Search within results...

L0 Set alert

Refine results

Open Access

[ ]All Open Access

[]Gold

[ ]Hybrid Gold
[ |Bronze

[ ]Green

Learn more

Year

[]2022

N\

(162,607) >
(62,710) >
(13,105) >
(74,979) >
(127,362) >

N\

(17,226) >

Documents

Search Source

2022 ) OR LIMIT-TO ( PUBYEAR, 2021) OR LIMIT-TO ( PUBYEAR , 2020))

Export document settings @

‘You have chosen to export 196547 documents

Select your methed of export

O & MENDELEY (O Ex|_||ms

Secondary documents

O scival® @ RIS Format
EncNote, Excel

Ocsv OBibTex () Plain Text
ASCIl in HTML

Dalyze se‘results

Reference Manager

What information do you want to export?

[m] Citation information [m] Bibliographical information [] Abstract & keywords [] Funding details [] Other information

[m] Afiiliations

IE Serial identifiers (e.g. ISSN)
[H] PubMed ID

[H] Publisher

[m] Editor(s)

IE Language of original document
[H] Correspondence address

[H] Abbreviated source title

[] Abstract
[] Author keywords
[] Index keywords

[] Number
[] Acronym

[] sponsor
[] Funding text

[] Tradenames & manufacturers
[] Accession numbers & chemicals
[] Conference information

[] Include references

o [m] Author(s)

. [m] Author(s) ID
[®] Document title
[m] Year
[m] EID

[m] Source title
IE volume, issue, pages
[H] Citation count

Document title

IE Source & document type
[H] Publication Stage

=] pol

[H] Open Access

Patient-related outcomes in patients re
clinic with persisting symptoms followi
CQOVID-19

Open Access

Cancel

View abstract v~ View at Publisher Related documents

2022 latreia 0

35(1), pp. 29-39

Mendivelso, F., Guevara,
C., Bernal, L., Lépez, L.,
Low, E.

Negative pressure protective barrier device used in dental
emergencies during the COVID-19 pandemic | [Dispositivo
de barrera protectora con presion negativa utilizado en
urgencias odontologicas durante la pandemia de COVID-19]



8y Scopus

el N
Export document settings @

You have chosen to export 196547 documents

Select your method of export ‘

(O M MENDELEY (D extibris (O Scival ® | (@ RIS Format (Ocsv (O BibTexX O
RefWorks EndNote, Excel in

‘ Reference Manager
What information do you want to export?
|i| Citation information . [m] Bibliographical information [ ] Abstract & keywords [ ] Funding details [ ] Other information
[m] Author(s) [m] Affiliations [ ] Abstract [ ] Number [ ] Tradenames & manufacturers
[W] Author(s) ID [W] Serial identifiers (e.g. ISSN) [ ] Author keywords [ ] Acronym [ ] Accession numbers & chemicals
[M] Document title [W] PubMed ID [ ] Index keywords [ ] Sponsor [ ] Conference information
(W] Year [W] Publisher [ ] Funding text [ ] Include references

(W] EID

(W] Source title

|§| volume, issue, pages
[m] Citation count

|§| Source & document type
[m] Publication Stage

[m] DOI

[m] Open Access

[W] Editor(s)

|E| Language of original document
[W] Correspondence address

[W] Abbreviated source title

‘lIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII-'
..IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII Il‘

*

.IIIIIIIIIIIIIIIIIIIIIIIIIIIII’

Cancel | Export



Direct export: Google Scholar

®, My profile My library

Google Scholar
B

® Articles Case law
New! Track and manage your public access mandates

Articles about COVID-19

CcDC NEJM JAMA Lancet Cell BMJ

Mature Science Elsevier Oxford Wiley medRxiv

Stand on the shoulders of giants

SIGN IN



Articles

Any time

Since 2021
Since 2020
Since 2017
Custom range...

Sort by relevance
Sort by date

include patents
v include citations

&4 Create alert

Google Scholar

About 1. 450 000 results

Coronavirus

coronavirus

(0.03 sec)

1. Click the Cite sign at the bottom of the record you need.
2. Click the EndNote to download data to your library.

World Health Organization - 2020 - pesquisa.bvsalud.org

Coronaviruses (CoV) are a large family of viruses that cause illness ranging from the
common cold to more severe diseases such as Middle East Ftes;::urat:::try,.r Syndrome (MERS-
CDV:I and Severe Acute Re-_:_-l.-_‘; [ P pUp— T T P LY I, WP | - pu——— Fam T VPN D~

¥ 99 Cited by 5108 F

HTML] Another decade
5 Perlman - 2020 - Mass I

Fort, *hird time in as mar

hum, 1 opulations. This vil
ZoChina, in persons ¢
Y¢ DY Cited by 742 Re

Coror = rus diseas:
F He, Y Deng, W Li - Journ
In late December 2019, a c

Wuhan, China. A few days |
identified as a novel coron:

Wuk

¥ UY Cited by 556 R

X

MLA

APA

Chicago

Harvard

Vancouver

Cite
1TML] nejm.org

Periman, Stanley. "Another decade, another coronavirus.
(2020): 760-762.

Periman, 5. (2020). Another decade, another coronavirus.

Perlman, Stanley. "Another decade, another coronavirus. ‘ )
(2020): 760-762. ’DF] wiley.com
Periman, 5., 2020 Another decade, another coronavirus.

Periman 5. Another decade, another coronavirus.

BibTeX = EndNote  RefMan RefWorks

2



1. Go to File > Import > File... to open the Import File dialog. ==~ <
4 || » ThisPC » Desktop » 2020 v | B O Search 2020 N
2. Click Choose to select a PDF file from your hard drive. e e Hewroe - m @

3. Select Import Option as PDF

# Quick access

1_: Al-Eitan-2020-Bat-Borne Coronaviru.pdf

26-Mar-21 10:37 A..,

Adobe Acrobat D. :

: & OneDrive 1_-. Dimonaco-2020-Computational Analys.p...  26-Mar-21 11:00 A...  Adobe Acrobat D..:
. . . [ [ - N ™ Hascksuz-2020-Coronaviruses and SA.pdf  26-Mar-2111:01 A..  Adobe Acrobat D.®
= [ ThisPC - "
4. Cl |Ck |mp0rt tO ImpOFt a PDF f||e IntO yOUI’ |Ibr8.ry Lo . = Keeling-2020-Efficacy of cantact.pdf 26-Mar-2111:02 A..  Adobe Acrobat D.=
30 Objects = Khan-2020-Emergence of a Novel.pdf 26-Mar-21 11:02 A.. Adobe Acrobat D.a
: [ Desktop :
a g 2020 v < )E
E File name: v| Al Files (%) v -
Open Library... Ctrl+=O o  Open | Cancdl |
OpEnSharEdLibrﬂl}'... Ctrtl+5hift+=0 :llllllllllllllllllllllllllllllllllllllllllllllllllll lllli’i:
Open Recent »
Close Library Ctrl+W _
Import File
Save Ctrl+5
Save A Al-Eitan-2020-Bat-Borne C
n- e Coronaviru,
Save a Copy... Import File I P ‘
Share...
Import Option:
‘ Import File.. Duplicates
Print... Ctrl+P Text Translation: No Translation ol
Print Preview
Print Setup... Cancel




Import PDF File (2)

EndNote 20 - SCBM496_1111111.enl

File Edit References Groups Library Tools Window

© Sync Configuration

[E All References 11

& Imported Referen... 1

Recently A
B Unfiled

Help

Imported References

Advanced search

Imported References

1 Reference

AQ@

W Trash
MY GROUPS
v My Groups
FIND FULL TEXT
GROUPS SHARE...
ONLINE SEARCH +
@ Jisc Library Hub ...
@ Library of Congr...

@ PubMed (NLM)
® Web of Science ...

Search for group

‘ Author

¢ Harshani Nadeeshani; Jinyao Li; T...

‘ Year ‘ Title
2022 Nicotinamide mononucleotide (NMN)...

E Nadeeshani, 2022 #67 Summary Edit PDF X
QB ~1]/12v —[e7% ]|+ D cC =Y=Nrd
1-s2.0-52090123221001491-main.pdf v
Lﬁj Journal of Advanced Research
Nicotinamide mononucleotide (NMN) as an anti-aging health product - | &

Promises and safety concerns

Harshani Nadeeshani”, Jinyao Li", Tianlei Ying ", Baohong Zhang ", Jun Lu =

HIGCHLIGHTS CRAPHICAL ABSTRACT

< . —*

ABSTRACT




Manual Typing (1)

New Reference (KN Library.enl) =
GO to References > New Reference File Edit References Groups Library Tools Window Help conference Peper 2
Conference Proceedings
A blank reference window appears. A 1 -
" Dictionary
SeleCt a Reference Type from the drOp—dOWn Reference Type | Journal Article - Discussion Forum
, \ Author Edited Book
menu. (the default type is Journal Article) -
Year
. . . ' ' Electronic Book
Enter bibliographic data into the fields. - e |
e ectronic Book Section
Saving reference by clicking the Save. Joura e
quation
Volume Figure
Part/Supplement Film or Broadcast
References J Groups Library Tools Windov ssue 3 enere
Government Document
New Reference Ctri+N pages Grant
Edit Reference Ctrl+E Start Page Hearing
Copy References To 4 . interview
Copy Formatted Reference Ctrl+K oumeLee _
_ . Epub Date Legal Rule or Regulation
c-Md :‘E fe rence Magazine Article
Move References to Trash Ctrl+D e Manuscript
Type of Article Map




Manual Typing (2)

How to enter the author's name
®* Enter one name per line.

®* New Terms appear in red text.

Author names formats

® First_name Middle_name Last_name
Albert Einstein
Albert Lester Lehninger

® Last name, First_ name Middle_name
Einstein, Albert
Lehninger, Albert Lester

Institute/Corporate name formats

® addacomma after the name.
World Health Organization,
Mahidol University,
ANUONYTANENS UKIONYIAUIURAA,

Thai author name formats
® addacomma after the name.

NUNWS JIUaoIsulsad,
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Inserting Citations (Find & Insert)

EndNoteTraining_KN.docx - Word

H S0

File Home Insert Draw Design Layout References Mailings

Review

View

[} EN Go to EndNote Style: |Vancouver -
Q @' Edit & Manage Citation(s) LE,' Update Citations and Bibliography

Insert
Citation « L% Edit Library Reference(s) B Convert Citations and Bibliography ~

1 ) |3—‘b, Insert Citation... Bibliography

E@- Categouri
Instan’

EndNote 21 Find & Insert My References

|Z_I’Q Insert Selected Citation(s)
E Insert Note...

!c: Insert Figure...

Open the Word document and place the cursor on the

position where you would insert the citation.

1. Go to the EndNote 21 menu, and select Insert Citation to
display the Find & Insert My References box.

2. Inthe text box at the top, enter text to find the reference
you wish to cite, then click Find.
Select the desired references from the search result.
Click Insert.

The inserted citation will appear in your manuscript.

[ Journal Article | [ Find 2  Uibrarles v
Author Year Title
Fishing Technique of Long-Fingered Bats Was Developed from a Primary Reaction to Disappearing Target Stimuli

Arnett 2013 Evaluating the Effectiveness of an Ultrasonic Acoustic Deterrent for Reducing Bat Fatalities at Wind Turbines
Blanco 2019 A shot in the dark: Sport hunting of declining corvids promotes the inadvertent shooting of threatened red-billed c
Brucks 2020 Parrots Voluntarily Help Each Other to Obtain Food Rewards
Clements 2018 Initial Evidence for Probabilistic Reasoning in a Grey Parrot (Psittacus erithacus)
Cornero 2020 Piagetian Liquid Overconservation in Grey Parrots (Psittacus erithacus)
Fraser 2011 Ravens Recondile after Aggressive Conflicts with Valuable Partners
Fujioka 2014 Rapid shifts of sonar attention by Pipistrellus abramus during natural hunting for multiple prey
Gorresen 2018 Multi-state occupancy models of foraging habitat use by the Hawalian hoary bat (Lasiurus cinereus semotus)
Holland 2008 Bats use magnetite to detect the earth's magnetic field
Koepke 2015 Delayed Gratification: A Grey Parrot (Psittacus erithacus) Will Wait for a Better Reward
Patterson 1994 A COMPARATIVE-STUDY OF HUMAN AND PARROT PHONATION - ACOUSTIC AND ARTICULATORY CORRELA1
Patterson 1998 Acoustic and articulatory correlates of stop consonants in a parrot and a human subject
Pepperberg 1981 FUNCTIONAL VOCALIZATIONS BY AN AFRICAN GREY PARROT (PSITTACUS-ERITHACUS)
4 >
Reference Type: Journal Article
Record Number: 17
Author: Aizpurua, O.

Alberdi, A.

Aihartza, J.

Garin, L.
Year: 2016
Title: Fishing Technique of Long-Fingered Bats Was Developed from a Primary Reaction to Disappearing Target Stimuli
Journal: Plos One
Volume: 11
Issue: 12
Pages: 12
Nato: Nar

4 Cancel Help

Library: My EndNote Library.enl

43 items in list




Inserting Selected Citations (from EndNote)

HS-0 -

File Home Insert Draw Design Layout References Mailings

L} EN Go to EndNote 1 Style:  |Vancouver -
Insfr)’: 12+ Edit & Manage Citation(s) LE,I Update Citations and Bibliography
Citation ~ [ Edit Library Reference(s) PR Convert Citations and Bibliography ~

Citations Bibliography
L R L Yoo

Open the Word document and place the cursor on the position

where you would insert the citation.

1. Go to the EndNote 21 menu, select Go to EndNote.

2. At your EndNote library, select the desired references.

3. Go to Endnote’s Tools menu, select

Cite While You Write [CWYW] > Insert Selected Citation(s)

The inserted citation will appear in your manuscript.

EndNoteTraining_KN.docx - Word

EndNote 21

| Export to EndNote ~
ill)} Manuscript Matcher

@ Categorize References ~
Instant Formatting is On ~

—-—
—* Preferences

Install EndNote Click Browser Extension

Output Styles

Import Filters

Connection Files

Cite While You Write [CWYW]
Format raper

Subject Bibliography...
Show Connection Status

Online Search...

Advanced searlch

Go to Word Processor Alt+1
Insert Selected Citation(s) Alt+2
Format Bibliography... Alt+3
Import Traveling Library... Alt+8
CWYW Preferences Alt+9

Pepperber...
Voss, R. S;;...

Chiu, C; M...

SENSITIVE PERIODS, SO...  Behavioral an...  8/3/2021

Roosting Ecology of Am...  American Mu...  8/3/2021

The role of the external ...  J Acoust Soc ...  8/3/2021




Inserting Selected Citations (from Word)

H ©9- 0 - EndNoteTraining_KN.docx - Word
File Home Insert Draw Design Layout References Mailings Review View Help EndNote 21 =
L} EN Go to EndNote 1 Style: ‘Vancouver - @Categorize References ~ Export to EndNote ~ 0
Insg‘t\ 12+ Edit & Manage Citation(s) LE,I- Update Citations and Bibliography Instant Formatting is On ~ il Manuscript Matcher elp
Citation ~ F‘-ﬂ- Edit Library Reference(s) R Convert Citations and Bibliography E Preferences
Citations Bibliography M Tools
L 1 L Yoo 2 o3 e o4

Open the Word document and position the cursor at

Pepperber... 1986 SENSITIVE PERIODS, SO... Behavioral an... 8/3/2021

the location where you would insert the citation. 2

Voss, R.S.... 2016 Roosting Ecology of Am...  American Mu...  8/3/2021

Chiu, C; M... 2007 The role of the external ...  J Acoust Soc ...  8/3/2021

1. Go to the EndNote 21 menu, select Go to
EndNote.

H ©- 0 - EndNoteTraining_KN.docx - Word
2. At your EndNote library, select the desired : , _ _ :
File Home Insert Draw Design Layout References Mailings Review View Help EndNote 21
references. |,, 1 EN Go to EndNote Style:  |Vancouver - iﬂ- Categorize References ~ ‘@ Export to EndN
3. Return to Word document. Go to EndNote 21 I Ort‘ F’,“ Edit & Manage Citation(s) LE,I Update Citations and Bibliography Instant Formatting is On ~ 008 Manuscript Mat
' ' nse
menu, select Insert Selected Citation(s) BB insert Citation. PV - ol

(e = F'g;(. Edit Library Reference(s) R Convert Citations and Bibliography ~ _.:_: Preferences

E Insert Selected Citation(s)

3

The inserted citations will appear in your manuscript. |51 nsert note...

!c: Insert Figure...




Edit & Manage Citation

= 4

Zotero CEN  EndNote 21

=l Evnort +0 EndNote v A

H ©- EndNoteTraining_KN.docx - Word
File Home Insert Draw Design Layout References Mailings Review View
55 EN Go to EndNote Style: |Vancouver M iﬁr Categorize References ~
| Qrt FII,[' Edit & Manage Citation(s) S upQuu.c LTS dliu L)I;J;IUHIE.I'J;I)’ E INETCTNS TUIlllutu;llg
nse
Citation + L Edit Library Reference(s) 1 Convert Citations and Bibliography ~
Citations Bibliography

1. Go to EndNote 21 menu, select Edit & Manage Citation(s) to display
EndNote 21 Edit & Manage Citations box.
2. You can add or remove citations from multiple citations or change the
order of citations.
* Edit Library Reference: select this command to edit the corresponding

references in EndNote directly.

®* Insert: Use this to add another citation within the same set of delimiters.

®* Remove: Highlight a citation and click Remove to delete it from the
in-text citation.
* Up and Down Arrows: Highlight a reference and use the arrows to
change the order of the display.
3. Click OKto implement your changes.

(4)
Voss, 2016 #198 1

My EndNote Library

EndNote 21 Edit & Manage Citations X
Citation - Count  Library
(1)
. . Aizpurua, 2016 #17 My EndNote Library Edit Reference| ~
(2.3) Edit Library Reference
4 Pepperberg, 2013 #137 1 My EndNote Library 2 Find Reference Updates
L Patterson, 1998 #66 1 My EndMote Library

Remove Citation
Insert Citation

Update from My Library...

Edit Citation Reference

Formatting: |Default v

Prefix:
Suffix:

Pages:

Tools -

Totals: 3 Citation Groups, 4 Citations, 4 References

Cancel

Help




Configure Bibliography

EndNote 21 Edit & Manage Citations

A~

Library

Edit Reference| =

My EndNote Library

Citation Count
(1)
B B 2izpurua, 2016 #17

(2,3)
Pepperberg, 2013 #137 1
Patterson, 1998 #66 1

4
Voss, 2016 #198 1

My EndNote Library Edit Reference| =
My EndNote Library Edit Reference| =
My EndNote Library Edit Reference| =

1. From EndNote 21 Edit & Manage Citations
box, click on the Tools menu at the lower
left corner, select Configure Bibliography

2. Onthe Layout tab, you can change or verify

these settings:

Edit Citation Reference

Formatting:  |Default v

Prefix:
Suffix:

Pages:

| lIndate Citations and Biblioaranhv |

| Configure Bibliography
| Export Traveling Library

Tools 1

Totals: 3 Citation Groups, 4 Citations, 4 References

EndNote 21 Configure Bibliography

Format Bibliograph  Layout 2

Font: Size:
Times New Roman ~ 12 v

Bibliography title:

REFERENCES

Text Format...

Start with bibliography number:

First line indent: | 0.000 in Line spacing: | Single M
Hanging indent: | 0.500 in Space after:  |None v

3 oK Cancel Help

* Font and Size: these are the text font
and size used for the bibliography.

® Bibliography Title: to print a title at the
top of your bibliography, type the title in
this text box.

* Text Format: highlight the bibliography
title text and then use the Text Format

button to display a dialog where you

can change the format of the
highlighted text.
3. Click OKto implement your changes.



Convert Citations and Bibliography

H 90 -+ EndNoteTraining KN.docx - Word

File Home Insert Draw Design Layout References Mailings Review View Zotero Help EndNote 21

5y EN Go to EndNote Style:  |Vancouver - é::- Categorize References ~ Export to EndNote ~ o
I Cr); E‘ Edit & Manage Citation(s) [Z! Update Citations and Biblioaraphy Instant Formatting is On ~ oy Manuscript Matcher Hel
nse —_— elp

ETRE Eﬁl. Edit Library Reference(s) B Convert Citations and Bibliography ~ = Preferences
Citations | BX Convert to Unformatted Citations E Tools
[E* Convert to Plain Text 1

Convert Reference Manager Citations to EndNote

EEI Convert Word Citations to EndNote

You may need to remove the ‘Cite While You Write’ field codes to share

EndNote 21 X your document with a publisher or colleague. Convert to Plain Text will save a copy

of your document without formatted ‘Cite While You Write’ field codes. The

This command will create a new copy of your Word document
! and remove all special EndNote markers from it. The new

document will appear in a new unsaved document window. formatted citations and the bibliography are saved as text. By following the steps;

The original file will remain opened and untouched.

1. Go to the EndNote 21 menu, select

Do you wish to continue?

Convert Citations and Bibliography > Convert to Plain Text
2 | oK Cancel 2. Word presents the notification box, read, and click OK to continue.

3. A copy of the document, without field codes will appear in a new document

window. Then you can save a new name for a copy of your document.



Contact Library

For more information or online service, please contact

https://stang.sc.mahidol.ac.th

@ lisc@mahidol.ac.th

E https://www.facebook.com/StangMongkolsukLibrary

@ @StangLibrary

X https://x.com/StangLibrary
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